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1. Import Parts

It is possible to import parts from other CostsMaster files but only in strictly
defined circumstances.  This feature is designed for situations where a very large
file is costed by several different draftsmen. 

Because parts in CostsMaster rely heavily on information defined elsewhere in a
bill, it is possible to import parts only from files that are identical in all essential
aspects. A full list of requirements appears below but the important points are
that Fee Earners, Categories, Parties and Individual Enhancement should be as
near to identical as possible.

The best way to achieve this is, before starting to cost the file,  to set up a Master
file from which copies are taken for the subsidiary draftsmen. It is important that
all draftsmen should not add rates, fee earners parties etc. to either Master or
subsidiary files. They must be added to all files simultaneously. In the case of
Fee Earners, the order in which they are added is of fundamental importance and
re-ordering them to be in the same order will not be sufficient.

Although each subsidiary draftsman must work on a separate part, once imported
to the master file this part can of course be merged with another part. This way it
is possible for one draftsman to cost, say, a file of party and party
correspondence whilst a colleague costs a solicitor and client file. 

How to Import Parts

Parts are imported by going to the File menu and selecting "Import Parts…". A
warning message is displayed advising you of the restrictions on importing parts.
If you use this feature often and are aware of the restrictions you can stop this
message appearing by going to the Options – Local Settings menu and ticking
the relevant box on the general tab.

A file selection dialog box then appears in which you can select the CostsMaster
file containing the parts you wish to import. Select the file, then click the Open
button. The program will then scan the imported file and compare its settings.
The results of this comparison are then displayed. Certain combinations of
settings may not be advisable or may indicate that the files are not as similar as
you thought. These items will be displayed as a warning. Other combinations of
settings may be completely incompatible and these will be displayed as errors. If
only warnings are displayed you have the option to continue with the import or to
abort it. If an error is displayed there is no option to continue and you must abort
the import. If there are no warnings or error messages the window will not be
displayed at all.

A window will then appear showing the parts in the imported file. By default all
parts are selected for import, but if you want to import only certain parts, you can
de-select the items you do not want included by clicking on the tick box next to
each. Click the OK button to import the selected parts.
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Restrictions on Importing Parts

The following restrictions are mandatory. The import cannot continue if any of
these situations are found to exist.

1. Fee Earners must be created in the same order as the Master file. It is not
sufficient that they are re-ordered to be in the same order. If there are
more fee earners in the imported file the import will not continue.

2. Categories should be identical. If there are more categories in either bill
the import will not continue.

3. The parties should be identical to the main file. If there are more parties in
either file the import will not continue.

4. Any individual enhancement must be in the same order as the Master file.
If there are more individual items in the imported file the import will not
continue.

5. Any summary assessment schedules defined should be identical. If there
are more items in the imported bill the import will not continue.

The following restrictions are advisory. Their existence may indicate that the
imported file is not as similar to the master file as you had thought. If any of these
situations are found to exist a warning will be given and you will have an
opportunity to abort the import.  It is your responsibility to ensure that any
differences will not adversely affect the import. 

1. The bill types should be the same.

2. The fee earner names should be the same.

3. The party names should be the same.

4. Any individual enhancement defined should have the same amounts.

5. Any period enhancement defined should be identical in both files and
should have the same amounts.

6. If any summary assessment schedules are defined the dates of the
hearings should be the same.

These restrictions will be met automatically if you always define a Master file from
which subsidiary files are created and ensure that none of the above items are
subsequently added to either file.

With the exception of part rates (for which see below) all "bill level" information
from the imported file will be ignored.  By "bill level" information we mean
anything recorded in the windows accessed from the second section of buttons
on the toolbar or from the Bill menu.
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Part Rates

Whilst Global Rates defined in the imported bill are ignored,  part rates defined in
a part being imported are retained. As you will be aware each part in CostsMaster
can use either Global Rates, rates defined in itself or rates defined in another
part.  When importing parts the following rules are applied:

1. Parts that are set to use Global Rates will use Global Rates from the
Master file. 

2. Parts that are set to use rates from their own part have the setting
retained. The rates will be retained so no further action is necessary.

3. Parts that are set to use rates from other parts are reset to use Global
Rates from the master file. The number of parts so reset is notified to the
user at the end of the import. Unless the global rates in the Master file
happen to be the same as the rates in the part previously used, it is likely
that you will need to manually adjust the rates settings for this part 

The easiest way to keep the correct rate information when importing parts is to
set up Global Rates in both files to be identical and to ensure that the parts being
imported are set to use Global Rates. Alternatively ensure that all parts use rates
from their own parts.
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2. Breakdown of Costs

Sometimes, instead of a full detailed bill, what is required is a breakdown of
costs. This can now be prepared using CostsMaster.

The breakdown of costs applies only to inter partes costs. It is available in any bill
with an inter partes element. In 6 column bills the CLS costs will simply be
ignored.

The breakdown of costs follows a similar format to the Summary Assessment
schedule where the work is broken down and shown by category as totals for
hearings, attendances, documents etc. There is no option to produce a schedule
of documents to accompany the breakdown – if more detail is required a full bill is
probably called for.

Due to the different way in which the costs are calculated, it is not unusual to
have a difference of a few pence between the profit costs on a bill and a
breakdown of costs.

Recording Work

There is very little difference between preparing a breakdown and preparing a full
detailed bill. Indeed, the option to produce a breakdown appears in the export
wizard and can be selected instead of or in addition to the full bill.

You can therefore cost a file in the usual way, recording work in CostsMaster as
you would do for a bill, and simply select the breakdown option when exporting.
By working in this way you can easily produce a detailed bill without the need to
re-cost the file.

On the other hand, if you are certain that you will never need a detailed bill, it is
possible to break down the file on paper and simply record the totals for each
category in each section.  When working in this manner you can simply create
one procedural step and record all court attendances there. Similarly only one
party is needed to record all attendances and telephone calls etc. Other work can
be recorded as a single entry in the documents & travelling and waiting sections
etc.

Working in this manner, whilst undoubtedly quicker in the short term, does mean
that you would need to re-cost the file should you need a detailed bill later. 

How Work is Summarised

Rates

Because a single category may have more than one rate if part rates are used,
the program will automatically create duplicate category names where this
occurs. 
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e.g if you have a partner using a rate of £180 in part one,
£200 in part two and £220 in part three it will appear as

Partner£180
Partner (2) £200
Partner (3) £220

Procedural Steps

No dates or descriptions from any procedural steps are used.

All attendances at Advocacy rate are shown under a single heading. The default
phrase for this is "Hearings without Counsel".

All attendances at Attendance with Counsel rate are shown under a single
heading. The default phrase for this is "Hearings with Counsel".

All attendances at Travelling & Waiting rate are shown under a single heading.
The default phrase for this is "Travelling & Waiting".

Parties

Party names are not used.

All personal attendances and miscellaneous extra attendances are shown under
a single heading. The default export phrase for this is "Attendances".

All long telephone calls are shown under a single heading. The default export
phrase for this is "Long Telephone Calls".

Telephone Calls, Letters Out and Letters In are shown similarly.

Miscellaneous Extra Attendances at travelling & waiting rate are included in the
general Travelling & Waiting section later.

Documents

Documents appear under their own heading.

Travelling & Waiting. 

This section also includes Miscellaneous Extra Attendances at travelling & waiting
rate.

Costs of Assessment

This section includes all attendances from the costs of assessment window. The
default export phrase is "Costs of preparing bill".
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Disbursements

Disbursements are broken down into Counsel's fees, disbursements attracting
VAT and disbursements not subject to VAT. They each have their own export
phrase.

If there is just one category the above items appear as a single ordinary item.  If
there is more than one category each item above will appear as a heading and
separate entries will appear below for each category for which work is recorded.

Breakdown Options

There is one export option which determines whether the Costs Draftsman's fee
as a percentage is included in breakdowns of costs. By default this is enabled. 

It is common for a paying party to seek a breakdown in an attempt to agree costs
without incurring the cost of preparing a detailed bill and in these circumstances
you may want to exclude the costs draftsman's fee.  We would point out,
however, that in our view the costs of preparing a detailed bill over and above
those of quantifying the costs are minimal. This is even more the case now that
you can use CostsMaster to generate a detailed bill or a breakdown at the touch
of a button.

Breakdown Phrases

There are a large number of export phrases relating to breakdowns which have
their own page on the Export Phrases window. 

Most of these mirror their equivalents for bills but are included to give you the
opportunity of customising the breakdown in a different way to the bill.
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3. Notice of Commencement of Detailed Assessment

From Version 2.4.10 the way that presets are used on the Notice of
Commencement window has changed. This was prompted by the introduction of
the new Court fees in January 2006 in which the court fee on the Notice of
Commencement for Family bills is now different from the County Court fee.

Rather than continue to add specific fees piecemeal. and in order to better
provide for the transitional provisions where either the new or old fee might be
used, we have decided to make the preset fees more flexible and closer in design
to the rates presets.

When you first run version 2.4.10 or later, if you have previously defined presets
for the Notice of Commencement fees, the program will attempt to convert them
to the new format and will display a warning message to this effect. This should
happen once only.

Presets Window

The Notice of Commencement page of the Presets window now looks like this:

 

Presets for Civil and Family matters are listed in the larger box towards the top of
the page, whilst those for Court of Protection matters are listed in the smaller box
below it.  When any of these items are selected the boxes in the panel in the top
right of the window will change to show details for the currently selected item. You
will see that you can specify the Court fee on assessment, Court fee for a default
costs certificate and the fixed costs on a default costs certificate for each preset
you create. You can also alter the description which is used only to help you
identify which preset to use.
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The 6 Civil/Family and 2 Court of Protection items shown are those created
automatically when converting from the old preset system to the current. When
this happens the program will utilise any figures you had previously defined for
these items. You can of course change the details for these or create new
presets by using the buttons at the top of each box in the usual way.

The instruments presets box at the lower left of the window is unchanged in this
version - new entries are added simply by typing in the box and items can be
removed by selecting and deleting text.

Notice of Commencement Window

The Notice of Commencement window has also changed to reflect the new
preset system.

The biggest change from the old version is the removal of the boxes to specify
the Court and the bill type. Previously, altering these caused the Court fees in this
window to change. This was fine whilst the number of presets was strictly limited.
However, you can now define as many presets as you like so CostsMaster now
leaves it to you to manually select and apply the preset you want.

To do this you simply click the "Presets" button and select the preset from the
pop up menu that appears.

The "Use Family Form" check box needs to be selected if you want to utilise a
d252 or d258a form for Family matters, otherwise the civil n252 or n258a forms
are used.

The "Inter Partes" check box needs to be selected for inter partes matters. Not
only does it enable the boxes below it that are only relevant for inter partes
matters but it tells the program to use the n252 / d252 form rather than the n258a
/ d258a form that is used for CLS only assessments.

Please note that clicking on the "Inter Partes" check box does not cause the
Court fees to be changed - it is up to the draftsman to apply the appropriate
preset or change the fees manually.
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4. Court Of Protection Bills

As of Version 2.4 CostsMaster includes support for Court of Protection bills where
the costs are to be paid out of a fund rather than inter partes.

Both the standard and Short Form bill types are provided and it is possible to
switch between them at any stage.

Bill Types

The type of bill produced is determined by selecting one of the Court of
Protection types from the Bill type box in the Bill Settings window.

The full Court of Protection bill is similar to a 3 column inter partes bill but has
support for routine letters written and the new export phrases. 

The short form bill closely follows the layout of the model bill produced by the
Public Guardianship Office for bills where the amount is below the current
prescribed limit. This form is similar to a breakdown of costs except that personal
attendances are listed in full. 
These attendances will display any description that you have recorded against
them. Please be aware that the attendances are grouped by fee earner only, not
by party, so it is necessary to refer to the party name in the description if you
want this information to be seen in the bill. Alternatively you can leave the
description blank and CostsMaster will insert an export phrase that optionally
includes the name of the party automatically.

Other attendances and documents merely have their totals displayed in the short
form bill and thus any descriptions you type in will not be included.

Success Fees and Summary Assessment Schedules cannot be defined for either
type of Court of Protection bill.

Routine Letters Written

The biggest difference between Court of Protection and other bills is that letters
received cannot be recorded for Court of Protection bills. Instead the storage
space is used to allow recording of routine letters written which is intended for
letters paying bills which are claimed in 3 minute units in the Court of Protection.
This can be seen in both the Fee Earners window and the Party Details window
where the column headed "LI" appears as "rLO" (routine letters out) in Court of
Protection bills.

Because the same internal storage space is used for both types, switching from a
Court of Protection bill with routine letters written will cause them to appear as
letters received in the new bill (and vice versa). When changing bill types from (or
to) a Court of Protection bill where routine letters written (or letters received) have
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been recorded, you will be given a warning and asked if you want to proceed.

Export Phrases

There are is a new export phrase to cover routine letters written which is
applicable to both types of bill. Also applicable to both types are alternative
phrases for the Court and matter on the front sheet (or header on the short form
bill). These default to providing text that is more applicable to this type of bill but
can be customised to display any text that you want.

Similarly there are new phrases for Assessment Details on the front sheet of
ordinary bills or the header on short form bills. Separate phrases are provided for
each.

Other phrases apply only to the short form bill. They allow you to specify the title
of the narrative, the wording used for the total of the attendances and the
certificate that appears at the end of the bill. The short form bill lists attendances
in full but where you have not typed a description, CostsMaster will insert an
export phrase which, by use of the ^1 variable, can automatically include the
name of the party.

Notice of Commencement

It is possible to create Notice of Commencement forms for both types of Court of
Protection Bill. These follow the layout of prescribed form N258b.

The Notice of Commencement window for Court of Protection bills is a simplified
version of the standard window. It allows you to record the Patient's name and
the Court fee.  A button to the right of the Court fee box lets you change the Court
fee to one of the preset types which can now be set in the Presets Window,
Notice of Commencement section..
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5. CLAIM 1 - Claims for assessed costs

CostsMaster now fully supports preparing a CLAIM1 (and CLAIM1A) for costs assessed by the
Court.

On page 7 of the Claim1 Settings window there are now controls that allow you to directly enter the
amount of profit costs, disbursements, Counsel's fees, costs of assessment and VAT directly from
the Assessment Certificate. 

These controls are only enabled when the control on page 1 of the CLAIM1 & CLAIM1A settings
window is set to "claim for costs assessed by the Court" . When this control is so set ANY COSTS
RECORDED IN THE FILE WILL BE IGNORED in favour of the figures entered on page 7 of the
window.

When a CLAIM1A is selected The Total Profit Costs control is disabled and instead the controls for
profit costs, enhancement and advocacy become enabled. These controls correspond with the
boxes in Section 2 of page 2 on the CLAIM1A form.

For bills under the fixed fee scheme that have been to the Court for assessment, the draftsman
should enter the assessed figures on the page 7 tab and complete the fixed fee information on the
CLAIM1A tab. CostsMaster will then produce a CLAIM1A claiming either the assessed profit costs
or the fixed fee as appropriate.
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6. Public Law Fixed Fee Scheme

From version 2.6 CostsMaster supports the Public Law Fixed Fee Scheme introduced in October
2007. CostsMaster now gives you the option of exporting either an ordinary CLAIM1 or a CLAIM1A
for cases falling under the scheme. For costs to be assessed by the Court CostsMaster will
produce the revised form of bill where enhancement and advocacy costs are shown separately
from base costs.

There is no new bill type for the CLAIM1A. Instead the CLAIM1 bill type is used (now renamed to
CLAIM1 / CLAIM1A) and the correct type of form can be chosen in the CLAIM1 & CLAIM1A
settings window.

Once the appropriate fixed fee is defined in the CLAIM1 & CLAIM1A Settings window, everything
else on the form is completed automatically. If the profit costs (less advocacy) exceed the
exceptional case threshold, the schedules and the rest of the form are completed in full in the
same way as if it were a CLAIM1. However if the exceptional case threshold is not exceeded the
claim is made on page 3 and the schedules are automatically completed for advocacy costs only.

For the most part a CLAIM1A is prepared in exactly the same way as a CLAIM1. There are a few
small differences however and these are detailed in the following sections.

Specifying Advocacy Costs

The fixed fee scheme differentiates solicitors' advocacy costs from the bulk of the profit costs. In
CostsMaster solicitors' advocacy costs are considered to be 

(a) any attendances claimed in a procedural step that is set to "Attendance without Counsel" or 

(b) any attendances claimed against a party that has been specified as containing advocacy costs.
The edit party window has a new check box labelled "Include costs in advocacy total on CLAIM1A
and fixed fee scheme bills" which, when ticked, will cause all attendances (but not letters etc.)
recorded against the party to be considered as advocacy.

Work recorded within the procedural steps will be claimed at the advocacy rate. Work recorded
against a party set to "Include costs in advocacy total..." will be claimed at the preparation rate.
Work recorded as travelling and waiting in either location will be claimed at the travelling & waiting
rate. 

By placing your work in the appropriate place you can choose the appropriate rate for a particular
piece of work whilst still having it classed as advocacy for the purposes of the CLAIM1A. It is
therefore the draftsman's responsibility to ensure that anything he intends to claim as advocacy is
claimed at the appropriate place in CostsMaster.

Please note that any work recorded within the travelling & waiting window will be considered as
base costs. For travelling & waiting costs to be considered as advocacy they must be recorded
either within a procedural step or as a miscellaneous attendance of a party set to "Include costs in
advocacy total..."

CLAIM1 & CLAIM1A Settings Window

The Claim1 settings window functions for both the CLAIM1 and the CLAIM1A and has been
renamed accordingly. Although the page numbering on the CLAIM1A is different from the CLAIM1,
the page numbering on this window remains with the CLAIM1 numbering even if a CLAIM1A is
selected. In addition to the CLAIM1 pages, the CLAIM1 Settings window now has an additional tab
for the CLAIM1A containing controls for the fields specific to the new form. 

At the beginning of page 1 of the window is a control with options for CLAIM1 and CLAIM1A. When
either of these options is selected any controls not relevant to the selected form are disabled,
saving you from accidentally completing an unnecessary field. In addition this control determines
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whether the final form that is exported is a CLAIM1 or a CLAIM1A.

The CLAIM1A v2 form, mandatory from 1 April 2008 but permissible to use now, does not require
distinction between work in the Family Proceedings Court and in other Courts. CostsMaster
Version 2.6.36 no longer supports the CLAIM1A v1 form.

Fixed Fees

On the CLAIM1A page of the CLAIM1 & CLAIM1A settings window you will find controls which let
you specify the factors that determine the fixed fee, such as location, Court and who you were
acting for. When you have completed all four controls the fixed fee is automatically completed with
the appropriate figure from the preset fees. 

The presets window has an additional screen containing a grid where these fees can be defined. 
Example preset fees are provided with the program but it is the draftsman's responsibility to ensure
that the correct fee is claimed. 

It is also possible to enter the fixed fee manually should you have the need to do so.

There are two new tools for fixed fee CLAIM1A analysis. The first analyses the currently open
CLAIM1A and reports whether the costs claimed are increased or decreased as a result of
claiming the fixed fee and by how much. The second does the same but for all the fixed fee
CLAIM1As within a directory, allowing you to analyse the net loss (or gain) for a large number of
files.

Bills for assessment by the Court

The format of bills for assessment by the Court has altered for work falling under the fixed fee
scheme. These changes have been made in order to show enhancement and advocacy costs
separately in the summary for inclusion on the CLAIM1A.  The changes to the bill format are:

1. The CLS profit costs (and VAT thereon) in the bill summary are replaced with separate totals for
advocacy, base costs and enhancement on base costs.

2. Advocacy costs are shown in italic where claimed.

3. Enhancement is shown in bold where claimed.

4. In addition there is an option to show enhancement subtotals separately from base costs. This
provides either separate subtotals for enhancement or separate enhancement summaries where
applicable. In addition claims for costs in the columns of bills show the base costs and
enhancement separately (with separate item numbers where applicable).

These options will assist the person making up the bill after assessment in identifying which figures
are to be added up for which total.

Exporting Fixed Fee Scheme Bills

Bills falling under the fixed fee scheme are costed in the same way as ordinary bills. On export
there will be an additional page with a tick box where you can specify that this is a fixed fee
scheme bill. This will automatically cause changes 1-3 above to be implemented. Below this box is
another that allows you to utilise change 4 above.

Once you have selected the options you want everything else is taken care of automatically. The
appropriate costs are shown in bold or italic text and the correct totals are carried forward to the bill
summary.

Exporting Fixed Fee Scheme Bills where only Advocacy is to be assessed.

Under the fixed fee scheme a bill must be submitted to the Court for assessment where the
advocacy costs exceed £2,500 even if the remainder of the costs qualify for a fixed fee. In this
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case the regulations provide that all the costs must still be shown in the bill but that the Court will
only assess the advocacy costs. 

In such bills an ordinary fixed fee scheme bill will suffice although it is recommended that a
sentence is added to the narrative explaining that only the advocacy costs are to be assessed. It is
a matter of personal choice whether you still show enhancement on core costs on these bills.
Should you not want to do so there is an option in the export wizard to achieve this.

Post assessment the draftsman should enter the assessed figures on the page 7 tab and complete
the fixed fee information on the CLAIM1A tab. CostsMaster will then produce a CLAIM1A claiming
either the assessed profit costs or the fixed fee as appropriate.
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7. File Location Changes

From version 2.5 the default location for some types of files has changed. This
has been done to make the program function better in multi-user environments
and to ease the transition to CostsMaster version 3.

Note for users of older Operating Systems:

Some of these settings use the current user's application data directory. This
special folder was only defined from Windows 98 onwards. On Windows 95 and
NT4 systems the program will use the program directory instead but the program
will not be multi-user compatible and will probably have difficulties when
upgrading to CostsMaster version 3. 

Settings, Profiles & Abbreviations

(cdc.ini, profiles.ini, <profile name>.ini, abbreviations.dat, clsabbrev.dat)

Old Location: <Program Directory>
New Location: <Current User's Application Data>\CostsMaster\Draftsman

These settings are automatically copied from the program directory when each
user first runs CostsMaster 2.5. These settings were previously shared amongst
all users but now are maintained individually for each user. 

Spelling Dictionaries

(british.adm, cmuser.adu, learning.adl, config.ini)

Old Location: <Program Directory>\Dictionaries
New Location: <Current User's Application Data>*\CostsMaster\Dictionaries

These settings are automatically copied from the program directory when each
user first runs CostsMaster 2.5. These settings were previously shared amongst
all users but now are maintained individually for each user. 

Default Save Directories

Old default: <Program Directory>
New default: My Documents\CostsMaster Files

The new value will be used for new installations only although the new folder will
be created automatically by the installation program. Users who upgrade can use
the new defaults by moving all your .cdc files to the above named directory and
then altering the Default Load Save Directory setting in CostsMaster (Options -
Local Settings - File Locations).
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Program Templates Directory

Old default: <Program Directory\Program Templates
New Default: My Documents\CostsMaster Files\Program Templates

The new value will be used for new installations only although the new folder will
be created automatically by the installation program. Users who upgrade can use
the new defaults by moving all your .cdt files to the above named directory and
then altering the Program Templates Directory setting in CostsMaster (Options -
Local Settings - File Locations).

Export Templates Directory

Old default: <Program Directory\Export Templates
New Default: My Documents\CostsMaster Files\Export Templates

The new value will be used for new installations only. For people who have
upgraded from 2.4 or earlier the export templates will be installed to a folder
called "Export Templates" within the Default Save Directory. If you have not
altered your Default Save Directory the Export templates will be installed over the
previous copies and you need do nothing further. However if you have altered
your Default Save Directory you may need to manually copy the export templates
to the Export Templates Directory (as defined in CostsMaster - Options - Local
Settings - File Locations).

Users who upgrade can use the new defaults by moving all the CostsMaster
Word templates to the above named directory and then altering the Export
Templates Directory setting in CostsMaster (Options - Local Settings - File
Locations).
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8. Moving CostsMaster to a New Computer

This guide describes the recommended method for transferring CostsMaster to a different PC. 

1. Ensure you are running Version 2.5.6 or later.
These instructions assume you have at least version 2.5.6 as the process for transferring
CostsMaster was simplified in this version. If you are running an earlier version please upgrade
before proceeding.

2. Remove the licence from the old PC

The CostsMaster licence is tied to the machine it is installed on. It is therefore necessary to
remove it from the old PC and later to add it to the new PC. To do this:

· On the old PC start CostsMaster. If it is already running ensure there is no unsaved work
as this process will cause the program to close without the opportunity to save work.

· Go to the Help menu and select "About".
· In the window that appears make a note of your Access Key. You will need this later.
· Click the button labelled "Deactivate this licence". Make a note of the Release Code that is

displayed. You will need this later.
· When you click OK the program will close. When it next starts it will be running in trial

mode and can still be used fully in this state.

3. Copy your settings to the new PC

If you followed step 2 your settings, abbreviations, export phrases and dictionaries will have been
backed up to a folder on your desktop called "CostsMaster Settings". If you did not follow step 2
then Start CostsMaster, go to the Options menu and click "Backup Settings". Then do the
following:

· Copy the entire "CostsMaster Settings" folder to your new PC. It doesn't matter where you
copy it as long as you can locate it on your new PC.

· On the new PC locate the folder you have just copied and open it.
· Double click the "install.bat" file. This will copy the settings files to their proper locations on

your new PC.

4. Install CostsMaster on the new PC

Download the latest version of the program from our web site and install it on the new PC. Start the
program. It will be running in trial mode so click the "trial button" and verify that it starts properly,
then exit the program for now.

5. Copy your files and templates from the old PC.

Copy your CostsMaster files, forms program templates and export templates from the old PC. For
details of how to locate them see the section on How To Locate your Save Files And Folders

We recommend copying them to the My Documents\CostsMaster Files folder with program
templates and export templates stored in sub folders with those names. Wherever you copy them
to make a note of the locations as you will need them in the next step.

6. Verify your settings and locations

· Start CostsMaster. Click the "trial button" to run in trial mode.
· Open the Abbreviations and Options windows and assure yourself that all your settings

have been successfully copied from the old PC.
· Go to the Options menu, click on "Local Settings" then select "File Locations" from the left

hand pane.
· If you copied your documents and templates to a different location to where they were on
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the old PC the paths displayed on the right hand pane will be showing the old locations.
Use the "browse" button (with the folder icon) to locate the correct directory for each.
When done close the Options window.

· Click the Open button and verify that it takes you to the correct location for your
documents. Satisfy yourself that all your documents have been copied over from your old
machine.

· Open a file then export it. If there is an error locating the template go back to the File
Locations window and ensure the export templates path is correct.

· Go to the file menu and select "New From Template". Verify that the dialog opens at the
program templates directory - it should have at least one file called default.dot - and if not
go back to the File Locations window to rectify it.

7. Activate CostsMaster on your new PC

If CostsMaster is running, close it. Start it up again but at the "trial" window click the "Activate"
button. Make a note of the Activation Code.

Email Technical Support with details of

· Your access key from the old PC
· The release code from the old PC
· The Activation code from the new PC

We will send you the corresponding access key as soon as possible. In the meantime you can use
the program fully in trial mode.

How To Locate Your Saved Documents And Templates

From Version 2.5 the default location for CostsMaster files and forms is
MyDocuments\CostsMaster Files. Program templates and export templates are stored in sub
folders e.g. My Documents\CostsMaster Files\Program Templates.

Prior to Version 2.5 the default location for CostsMaster files and forms was the program directory
(by default C:\program files\CostsMaster. Program templates and export templates were stored in
sub folders.e.g. C:\program files\CostsMaster\Program Templates.

Please note that users who installed the program on their computer prior to version 2.5 may find
their files stored in the earlier locations as the storage location was not automatically changed on
upgrading.

Whilst this is the default location you may have customised CostsMaster to save some or all of
these files to different locations. To establish the current default location for your files and
templates:

· Start CostsMaster
· Go to the Options menu and click on "Local Settings"
· Select "File Locations" in the left hand pane
· The right hand panel will display the default locations for your CostsMaster files,

CostsMaster forms, CostsMaster program templates and Word export templates.

Please note that whilst this is the default location, files of these types could be saved in other
locations on your PC. If you are transferring files to a new PC we would strongly recommend you
search your entire system for files with these search strings:

File Type Search For

CostsMaster Files
*.cdc

CostsMaster Forms *.cmf

CostsMaster Program Templates
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*.cdt
Word Templates ** *.dot
 
** you will probably find many word templates on your system but you only need to copy any
templates you have altered manually. When you install CostsMaster on your new PC it will install a
complete set of the latest templates.
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9. Other New Features

Summary Assessment Schedules

The Summary Assessment Schedules feature was introduced in Version 2.2.
Version 2.3 adds the following refinements:

1. Hearings with a date in the future have a new export phrase which is
included after the category name which can be used to indicate that
these are estimated costs.

2. There is a new export option to produce a schedule of work to
accompany the schedule. This can be used to back up the summary
contained in the schedule on assessment if necessary.

3. There is a new export option to include disbursements recovered on
summary assessment in the bill. This is done to make plain that the
disbursements have not been overlooked but have already been
assessed. When they are included a new export phrase is appended
after the disbursement description to indicate that the item was recovered
on summary assessment. This phrase can be found in the
Disbursements section of the Export Phrases window and can also be
used to record the amount of the disbursement. When included in this
way the amount of the disbursement will not be shown in the columns.

4. The amount recovered on summary assessment can now show
disbursements separately from profit costs. The export phrase used to
show costs recovered on summary assessment now accepts a third
variable to represent the disbursements. The default phrase for new
installations uses this variable automatically but existing users will need
to update their export phrase manually. The phrase can be found on the
procedural steps window. The default phrase is now: 

Costs recovered on summary assessment (profit costs: ^1, disbursements: ^3,
VAT: ^2)

Success Fees

1. There is a new export option to include costs which have been summarily
assessed and are not claimed as part of the current bill in the success
fee calculation.

2. There is a new export option to exclude timed attendances recorded in
the costs of assessment window from the success fee calculation.

3. There is a new export option which lets you round up the success fee to a
whole number. Three options are available: "Show exactly" includes the
success fee to the nearest penny.  "Round to the nearest pound" will
round the figure up or down to the nearest pound, and "truncate pence"
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will simply ignore the pence (i.e. it will always round down).

4. The option to exclude success fees from the costs draftsman's fee
calculation now applies to success fees claimed in any part and not just
the part in which the costs draftsman's fee is claimed.

5. The Counsels' success fee grid now has two new columns. "VAT" lets
you specify whether VAT is applicable to Counsel's success fee and
"Limit" allows you to specify whether the Counsel's fee is limited to the
same figure as the solicitor's success fee.

6. There is a new export option which allows you to specify whether zero
rated success fees are shown in the bill. By default this is enabled as it
acts as a safety measure in case you overlook something and fail to
notice that the success fee is missing, but it can be disabled if, for
example, you only want to claim a disbursement under the Additional
Liabilities heading.

CLAIM1s

1. It is now possible to separate out the costs in part 1 from the other parts
whereas this was not previously possible. 

2. There is a new export option to show the part number in the addendum.
This applies only to parts specifically selected in the export wizard. There
are other circumstances that can cause the costs from some parts to be
shown separately in the addendum, such as different rates, VAT rates,
care & conduct etc., and in such circumstances the part number will not be
shown even if this option is selected.

3. The CLAIM1 Settings window has two new pages for pages 8 & 9 of the
CLAIM1 form. Whereas these pages of the form could previously be
completed manually in the form viewer, you can now record the
information in CostsMaster and it will be retained in the .cdc file in case
you need to make an amendment and re-export the CLAIM1 at a later
date.

Front & Back Sheets

1. There are new export options relating to the front and back sheets which
now has its own page on the export options window. 

2. The word "B E T W E E N" is no longer exported as part of the title if no
parties have been recorded as might be the case in adoption proceedings.

3. There is a new certificate on the CLS family backsheet to comply with
Article 3(1)(c)(i) of The Family Proceedings Fees Order 2004 granting fee
exemptions when the assisted person is a minor.
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4. The Case No. box on the front sheet window now allows you to input
multi-line text making it easy to record more than one case number.

Exported Bills

1. It is now possible to customise the header inserted into bills with the new
export phrases that have been created for this purpose.  Headers can be
defined separately for bills and schedules and variables are available to
include the current date, your reference, the file name and your company
name (if required). 

2. Schedules now have page numbering automatically added.

3. Travelling & Waiting items now use the Rates Description Assignment for
documents rather than always using Description 1 as has hitherto been the
case.

Care & Conduct

Care & Conduct, which has only ever been intended for the old family prescribed
rates which included such an element, is now unavailable for inter partes only
bills. It is also discouraged for 6 column bills because it can give a misleading
result with the inter partes costs. Instead we recommend that the care and
conduct is added to the rates and that this is explained in the narrative.

Presets

1. There is a new preset for the High Court fee on a Default Costs Certificate
which now differs from the fee in the County Court and family proceedings.
You will need to set this fee manually but after that the correct fee will be
applied when you start filling in details or (optionally) when you change the
Court or bill type.

2. There is a new button on the rates preset window which allows you to
make a copy of an existing rates preset. This can be useful if you are
creating a preset that is very similar to an existing one and saves you
having to type in all the figures manually.

3. On the Rates and Fee Earners window, when you right click on the Rates
by Category grid you will see a new item that lets you add an existing set
of rates as a preset directly, rather than entering them manually. 

Enhancement

1. There is a new option on the enhancement window labelled "Do not
exclude Fee Earner Enhancement". When this is selected excluding an
item by selecting "exclude" in the enhancement column of an attendance
grid will exclude all enhancement other than Fee Earner enhancement.
This can be used to good effect on Family bills where you can claim a Fee
Earner enhancement for panel members of 15% plus other enhancement
for additional difficulty. When you exclude an item, for example because it
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is routine work, the guaranteed 15% will still be claimed on it.

Please note that no enhancement will be claimed for attendances on a
party that has been excluded from enhancement. Similarly if a Fee Earner
is excluded from enhancement then enabling this option will have no effect
on work for that fee earner.

2. The export phrase used when the amount on which enhancement is
claimed is shown has changed. Previously you could include the amount
by including the variable ^1 in the phrase. There are now two additional
variables: ^2 lets you show the time on which enhancement is claimed in
hh:mm format and ^3 lets you show the time in words.

For example setting the phrase to

on ^1 (^3)

will cause the bill to export

Enhancement sought at 25% on £240.00 (1 hour 36 mins):      £60.00

whereas setting it to

(on ^2)

will cause the bill to export

Enhancement sought at 25% (on 1:36):      £60.00

Tools

1. There is a new tool which checks the file and reports on the amount and
value of estimated time in the bill. This can be very useful for advising a
client on the likelihood of the bill being reduced on assessment.

2. The Verify Counsel's fees tool has been expanded. As well as checking all
procedural steps with Counsel's fees to ensure they are set as
Attendances with Counsel, it now checks all procedural steps that are set
to "with Counsel" and warns the user if no Counsel's fees are defined.

3. There are two new tools for fixed fee CLAIM1A analysis. The first analyses
the currently open CLAIM1A and reports whether the costs claimed are
increased or decreased as a result of claiming the fixed fee and by how
much. The second does the same but for all the fixed fee CLAIM1As within
a directory, allowing you to analyse the net loss (or gain) for a large
number of files.
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Other features

1. New graphical menus

2. There is a button to deactivate your CostsMaster licence should you need
to move it to a new PC. This button will cause a release code to be
generated which you will need to send to us together with the activation
code for the new PC. After deactivating the licence CostsMaster will revert
to trial mode.

3. The program will now warn users if they switch input languages. This can
be done inadvertently by a shortcut in Windows XP that is very similar to a
CostsMaster shortcut. The result is that the keyboard suddenly becomes
American with the wrong characters appearing.

4. Minor changes to the export templates relating to Page size and default
language.

5. Improvements to Narrative window which should now retain the cursor and
selection after saving the file.
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